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El objetivo de este manual no es crear un cuarto de baño 
hiperrealista sino aprender a utilizar distintas técnicas de 
modelado en Blender. Es un manual para novatos hecho por 
otro novato, yo llevo poco tiempo en este mundillo así que 
habrá cosas que estén medio bien, cosas que estén 

regularmente hechas y alguna barbaridad que si la ve alguien con más 
experiencia en esto se dirá a si mismo “Madre mía la que ha liado este 
para hacer esto con lo fácil que es hacerlo de esta otra manera...”. Aún así 
espero os sirva. 
 
 
 
 
 
 
 
 
 
 
 

Bibliografías varias: 
 
− Guía Oficial de Blender. Ton Roosendaal y Stefano Selleri. 
− Blender Wiki. http://wiki.blender.org 
− 24 Horas Blender y Yafray. Carlos González Morcillo. 
− Creación de pelo. Ángel Paterna. http://angelpaterna.blogspot.com 
− Creación de Ropa. Soliman. http://apuntesdeblender.iespana.es 
− Projection Painting. 

http://wiki.blender.org/index.php/Dev:Ref/Release_Notes/2.49/Projection_Paint 

− Baldosas; http://www.foro3d.com/f111/suelos-cuadros-con-blender-69730.html 
 
 
 
Y sobre todo... ¡¡¡ mucho 3dpoder !!!   www.foro3d.com 
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Abre Blender presiona AA para seleccionar todo lo que hay en la escena y pulsa Supr para borrarlo. 
Pulsa Num 1 para cambiar a la vista frontal.   
Vamos a empezar con el lavabo; 
 
Pulsa Espacio->Mesh->UVsphere y dale a OK, déjala como está con 32 segmentos y 32 anillos; 
 

 
Pulsa TABULADOR para entrar en modo edición, pulsa A para deseleccionar todos los vértices. 
Amplia un poco la imagen con la rueda del ratón y pulsa B para seleccionar vértices, selecciona la 
mitad superior sin coger el 'ecuador' de la esfera y pulsa Supr. Para borrar estos vértices; 
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Vamos a achatar un poco la semiesfera que nos ha quedado para no hacer tan profundo el lavabo. 
Selecciona uno de los vértices superiores y pulsa SHIFT+S para hacer que el cursor se posicione en 
ese vértice. A continuación cambia el pivote a 3D cursor para escalar desde ese punto; 
 
 
 
 

 
 
 
 
 
 
 
 
Pulsa A o AA según el caso para seleccionar todos los vértices. Pulsa S + Z + .5. Con esto se 
escalará sólo en el eje Z a 0.5 su tamaño o sea a la mitad. 
 
Ahora Pulsa NumKey 7 para acceder a la vista superior; 
 
 
 
 
Vamos a achatar también la parte posterior del lavabo, pero antes vamos a mover un poco el último 
círculo que será el agujero del desagüe. 
 
 
 
 
Amplia un poco la imagen y selecciona el último círculo, para 
ello pulsa ALT+BDR, a continuación selecciona también el 
último vértice de la esfera con SHIFT+BDR, con esto se 
seleccionarán todas las caras. 
Antes de escalar comprueba que 
has vuelto a poner el pivote en su 
punto medio;  
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Pulsa ahora S para hacerlo un poco más chico y después G + Y para moverlo en el eje Y un poco 
hacia abajo. 
 
 
 
 
 
 
 
 
Bien, pulsa ahora A para deseleccionar los vértices. Pulsa B y selecciona la mitad superior, entonces 
pulsa S + Y para escalar esa parte. Como verás queda un poco separado, pulsa G + Y para acercarla 
un poco;  

 
Selecciona ahora todos los vértices con A, y pulsa SHIFT+D para duplicarlos. Pulsa ESC para 
dejar de mover el duplicado y dejarlo centrado. A continuación pulsa S y escala este duplicado para 
hacerlo un poco más grande que el original. 

 



Cuarto de Baño en Blender. V0.1                                 Ricardo Romero 2009.                 Pág.  6 

Ahora vamos a hacer un poco más ancha la parte donde irían los jabones y tal y cual. 
Para ello pulsa A para deseleccionar todos lo vértices. A continuación pulsa CONTROL+1 para 
ver la parte trasera del lavabo.  
 
 
 
En la barra de herramientas de la ventana pulsa el botón para ocultar las caras que 
no se deberían ver en esta vista (Si no te aparece ese botón pulsa Z para cambiar 
de modo) y pulsa B para seleccionar todos los vértices que se ven; si giras un poco 
la vista pulsando ALT+BIR verás que hay algunos vértices que se han seleccionado que no 
queremos que se seleccionen; 

 
La última línea no la queremos ni el semicírculo de abajo tampoco, sin embargo hay algunos otro 
vértices que no se han seleccionado que si queremos, así que pulsando SHIFT ve deseleccionando 
y seleccionando hasta que quede como en la siguiente imagen. Para deseleccionar las dos últimas 
líneas y el semicírculo de abajo lo podéis hacer pulsando SHIFT+ALT+BDR más fácilmente.  

 
 
Ahora pulsa 7 para acceder a la vista superior y pulsa G + Y para mover un poco hacia atrás la parte 
seleccionada; 
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Ahora vamos a unir las dos piezas creando caras, para ello selecciona con ALT + BDR el loop de 
aristas de una de las piezas y después selecciona también el otro con SHIFT+ALT+BDR. 

A continuación pulsa la 
tecla F para crear las caras 
y elige Skin Faces/Edge-
Loops y se crearán 
automáticamente. 
 

 
 
 

 
La parte donde va el grifo y los jabones está demasiado inclinada, selecciona con ALT+BDR el 
loop de aristas interno. A continuación deselecciona la parte de abajo, para ello pulsa B dos veces y 
verás que aparece un círculo para seleccionar, si mantienes pulsado la rueda del ratón 
deseleccionarás los vértices que no quieras. 
 
 

 
Cambia a vista frontal (NUMKEY 1) y sube un poco estas aristas con G + Z. Si no ves bien lo que 
estás haciendo desactiva el botón para poder ver las caras de detrás.  
Súbelo hasta casi donde están las aristas de detrás pero no tanto. 
 
Una vez hecho esto vuelve a pulsar el botón para no ver las otras caras de detrás. Y pulsa 
NUMKEY 7 para ir a la vista superior. Pulsa CONTROL + R para hacer un corte de las caras 
superiores. Una vez seleccionada la posición muévela para acercarla un poco al borde. 
Repite el corte y esta vez muévelo para dejarlo cerca del borde interior, tal que así; 
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Ahora vamos ha hacer una pequeña hendidura que sería donde irían los jabones. Para ello antes 
vamos a mover un par de aristas que es el pequeño hueco que se suele ver para que no se estanque 
ahí el agua;  
 
Selecciona la arista de la imagen y muévela (G) un poco hacia un lado. 

 
 

 
 
 

 
 
A continuación ve a modo de selección de caras y selecciona las siguientes caras. 
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Ve a la vista frontal (1) y pulsa E + Z para extruir hacia abajo estas caras. Cambia un poco la vista 
si no ves bien lo que estás haciendo. 
 

 
Si salís del modo edición con TAB veréis que ha quedado un poco feo, pero si añadís el 
modificador SubSurf desde la pestaña Modifiers->Add Modifier->Subsurf->Levels = 2, (o 
directamente pulsando CONTROL + 2) veréis que se suaviza, ya queda algo mejor. 
 
Si se viese alguna sombra extraña, ve a modo edición selecciona todos los vértices y pulsa   
Control + N para recalcular las normales hacia fuera. 
Si vamos la vista lateral (3) veremos que la parte que debería ir pegada a la pared es curva, también 
queda curva desde la vista superior (7) para arreglar esto vamos a hacer lo siguiente; 

 
Entramos en modo edición (TAB) y seleccionamos desde la vista superior (7) un vértice de los que   
están más arriba. A 
continuación pulsamos 
SHIFT + S y elegimos 
Cursor Selection para 
desplazar el cursor al 
vértice seleccionado. 
 
 
 
 
Ahora vamos a la vista contraria a la frontal (CONTROL + 1) para seleccionar los vértices que 
deberían ir pegados a la pared, es más cómodo haciéndolo pulsando B y deseleccionando y 
seleccionando con BB hasta quedar tal que así; 
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Ahora cambia al modo 3D pivot y vuelve a la vista superior (7) y pulsa S + Y + cero, con esto 
todos los vértices se pondrán a la misma altura que el que teníamos seleccionado. 

 
 
 
 
 
Ahora vamos a crear el agujero del desagüe. Antes de nada ve a la vista posterior con CONTROL 

+ 7 selecciona el vértice del círculo que dejamos y bórralo. 
 
Ahora desde la vista superior (7) seleccionamos el círculo del desagüe para ello selecciona el  
 Vértice del centro si te cuesta seleccionarlo mueve un poco la vista con ALT + BIR. Y luego 
selecciona el circulo de alrededor con ALT + BDR. 
 
 
 
Cambia a una vista más cómoda. 
Ahora vamos a extruir esta región hacia abajo con  
E + Z.   

 
 
 

 
 
 
 
 
Ahora seleccionamos el círculo superior y lo volvemos a extruir, 
pero esta vez hacia arriba y solo un poquito. E + Z. 
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Ahora cambia a la vista superior y vuelve a estruir este 
círculo, esta vez cuando estés extruyendo pulsa S para 
escalar hacia afuera tal que así; 
  
 
 
 
 
 
Sin deseleccionar nada cambia un poco la vista y pulsa 
G + Z para mover hacia abajo un poco este círculo. Ahora extruye una última vez y pulsa E + Z 
para bajar hacia abajo estas aristas. 
 
 

 
 
Ahora vamos a hacerle los agujeros, para ello sal del modo edición y añade a la escena un cilindro,  
con Espacio → Mesh → Cylinder, por ejemplo de 12 vértices. Hazlo más pequeño hasta que el 
círculo de la base sea más o menos igual de grande que el agujero que queremos hacer, hazlo un 
poco alargado para manejarlo mejor. Una vez hecho llévalo hasta el desagüe y en vista superior 
colócalo de la siguiente manera; 
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Ahora selecciona el lavabo que habíamos hecho y selecciona el vértice del centro del desagüe, pulsa 
SHIFT + S y selecciona Cursor → Selection para poner el cursor ahí. 

 
Ahora sal del modo edición y selecciona el cilindro, pulsa TAB para entrar en modo edición en el 
cilindro. Vamos a duplicarlo, para ello hacemos los siguientes sencillos cálculos; 
Como queremos tener 6 agujeros dividimos 360º de la circunferencia entre 6, o sea 60º. Como ya 
tenemos uno de estos cilindros solo queremos poner 5 más así que multiplicamos 60 x 5 = 300. 
 
 
Bien una vez hecho esto id a la pestaña Mesh Tools (F9), 
vamos a hacer un SPIN DUP o sea duplicarlo siguiendo 
una circunferencia, le decimos que 5 pasos para copiarlo 5 
veces y en Degr le decimos 300 º. 
 
 
Una vez puesto esto pulsamos en Spin dub. 
 
 
 
 
 
 
 
Quedará tal que así; 
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Ahora vamos a restar los dos objetos para hacer los agujeros en el desagüe. 
Para hacer esta resta vamos a separar el último círculo del lavabo del propio lavabo ya que no tiene 
mucho sentido hacer la intersección de estos cilindros con tooooodo el lavabo. 
 
Para ello sal del modo edición de los cilindros (TAB) y entra en el modo edición del lavabo (TAB), 
selecciona el círculo seleccionando sus aristas y el vértice central y pulsa P para separar este círculo 
del lavabo y después Selected; 
 
 
 
 
 
 
 
 
 
 
 
 
Sal del modo edición y selecciona este circulo que has separado y los cilindros pulsando SHIFT, 
pulsa / en el teclado numérico para ver solo estos dos objetos y trabajar mejor. A continuación 
selecciona solo el círculo y entra en modo edición (TAB). Pulsa E + Z para extruirlo y hacerlo un 
poquito más ancho. Quita antes el modificador Subsurf que tiene el círculo ya que lo tenía también 
el lavabo del que lo hemos separado. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Vamos a hacer la resta de los dos objetos, sal del modo edición del círculo y selecciona primero el 
objeto al que le quieres restar o sea el círculo y a continuación con SHIFT selecciona los cilindros. 
El circulo que has seleccionado primero estará en rosa oscuro y los cilindros en rosa claro, ahora 
pulsa W y Difference y restarás los dos objetos.  
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Aunque parezca que no ha pasado nada si mueves los objetos te darás cuenta de que ahora tienes 3 
objetos, los 2 que tenías y uno nuevo que es la diferencia de ambos. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 

Si al hacer la intersección te hace alguna cosa rara y no se crea 
bien, entra en modo edición del círculo selecciona todos los 
vértices y pulsa CONTROL+N para poner las normales hacia 
afuera. 
 
Bien borra, los 2 primeros y quédate con el último generado que es el que nos interesa.  
Ahora vuelve a unir el desagüe con el lavabo, para ello selecciona los dos objetos con SHIFT y 
pulsa CONROL + J → Join selected meshes, al unirlas se volverá a aplicar el modificador subsurf 
al desagüe creado automáticamente. 
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Vamos a añadir el tornillo que sujeta el desagüe, para ello entra en modo edición en el lavabo y crea 
una esfera, escálala al tamaño adecuado y ponla en el sitio donde debería ir el tornillo. Pulsa R + Y 
+ 90 para rotarla y vuelve a pulsar R + Z + 90 para volver a rotarla tal que así; 
 

 
 
 
 
 
 
 
 
 
 

 
 
Achata la esfera un poco con S + Z, selecciona las 8 caras de la imagen y estrúyelas hacia abajo con  
E + Z.  Si queda muy ancha la ranura hazla más chica con S + Y. 
 
 

 
 
 
 
Bueno, vamos a empezar a modelar el grifo, para ello 
añadimos a la escena un cilindro; SPACE →   ADD 

→ Mesh → Cylinder y lo escalamos hasta el tamaño 
que veamos conveniente; 
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Seleccionando dicho cilindro pulsamos / en el teclado numérico para que se vea en la escena solo 
este objeto y trabajar más cómodamente. 
Para salir de ese modo lo hacemos volviendo a pulsar /. 
 

 
 Vamos a la vista frontal (1) y entramos en modo edición 
(TAB). Pulsamos CONTROL + R y creamos dos cortes. 
 
Pasamos a modo selección de caras  
y seleccionamos las siguientes caras: 
 
A Continuación pasamos a vista lateral (3) y pulsamos E para 
estruir dichas caras. 
 
 
 
 

Al terminar de extruir pulsamos G para moverlas un poco 
hacia arriba. A continuación pulsamos S + Z para escalar 
en el eje Z. 
 
Una vez hecho esto volvemos a estruir. Una vez hecho esto 
seleccionar la arista que queda en medio con ALT + BDR; 
 
 
 
 
 
 
 

 
En vista superior (7) escalar un poco hacia adentro (S). 
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Vamos a añadir ahora el monomando. Pulsamos SPACE → ADD → Cylinder, aparecerá un 
cilindro enorme y girado distinto a como tenemos el otro.  Bien, si estás en vista lateral (3) pulsa R 
+ Y + 90 y rotarás el cilindro 90 grados. 
 
Bien, escálalo hasta que quede más o menos como en la 
imagen, un poco más ancho que el otro cilindro; 
 
Ahora selecciona la cara de arriba seleccionando el 
vértice central y el círculo que lo rodea con SHIFT + 

ALT + BDR. 

 
Estando en vista lateral (3 ó control+3) vamos a rotar 
esta cara. Pulsamos R + X para rotarlo en el eje X y 
quedará tal que así. 

 
 
A continuación 
añadiremos un corte con 
CONTROL + R y lo subimos hasta arriba.  
 
 
 
 
 

 
En vista frontal (1) y selección de caras, seleccionamos las caras que 
se indican y en vista lateral (3) las extruimos.  
 
Una vez extruido volvemos a estruir una vez más, estas dos últimas 
estrusiones las vamos a hacer un poco más pequeñas desde la vista 
superior. 
 
 
 
 
 
 
Girar un poco el mando para que no se vea tan 
artificial la cosa... (7 → R + Z ) 
Para suavizar el modelo pulsar el botón Set Smooth 
en la pestaña Link And Materials (F9). 
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Vamos a añadir al grifo el tubo por donde sale el agua, para ello vamos a la vista interior (Control 
+ 7 ), añadimos un cilindro y lo escalamos para que quede de la siguiente manera; 

 
 
 
 
 
 
 

Volvemos a la vista inferior, seleccionamos la base del cilindro y la extruimos, no la movemos de  
sitio simplemente la hacemos algo más pequeña. 
A continuación pasamos a vista lateral y volvemos a estruir pero esta vez movemos hacia arriba, E 
+ Z. 

 
 
 
 
 
 
 
 
 
 
También he añadido un pequeño cilindro en el mango para a la hora de poner las texturas dividirlo 
en rojo y azul para indicar el agua caliente y fría; 
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Bueno, vamos a crear ahora el pie del lavabo, vamos a la vista inferior con CONTROL + 7 y 
seleccionamos en modo de selección de aristas el siguiente loop de aristas con ALT + BDR. 

 
 
 
A continuación lo vamos a duplicar con SHIFT 

+ D para que no se vea tan unido y suavizado por 
el subsurf al lavabo. Una vez duplicado pulsa 
ESC o BDR para que no se mueva del sitio y 
dejarlo como está, verás que el duplicado es un 
poco más grande que el original pero es porque 
no le afecta todavía el subsurf. 
 
 
 
Bien, cambia a vista lateral (3) y estruye hacia 
abajo con E + Z, estruye solo un poco y luego 
vuelve a estruir una vez más moviéndolo esta vez 
un poco más abajo. 
 
 

 
 
A continuación selecciona el loop de aristas que ha quedado en medio con ALT + BDR y hazlo un 
poco más pequeño con S . 
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Si te fijas bien esta base del lavabo no ha quedado tan suavizada como la otra, para arreglarlo entra 
en modo edición, selecciona algún vértice de la base y pulsa L, con esto se seleccionará todo lo que 
esté unido a este vértice o sea la base. A continuación pulsa el botón Set Smooth para suavizar (F9) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Si quedan algunas líneas oscuras raras tal que así, entra otra vez en modo edición de objetos y con 
todos los vértices de la base seleccionados pulsa CONTROL + N para recalcular las normales 
hacia afuera.  
 

 
Si vemos que ha quedado un pequeño hueco 
entre la base y el lavabo en la parte que va en la 
pared; 
 
 
 
 
 
 
 
 
 
 
 
 
 
Solo tenemos que seleccionar estas aristas en 
vista trasera CONTROL + 1 y echarlas un poco 
hacia arriba con G + Z. 
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Ahora vamos a hacer el tapón del lavabo con su cadena, lo primero 
que vamos a hacer es el punto donde irá unida la cadena en el grifo. 
Para ello selecciona el grifo, entra en modo edición (TAB) y ve a 
vista superior (7) añade un cilindro (Space → Add → Cylinder ) 
escálalo para hacerlo más pequeño (S) y rótalo (R + X + 90). Juega 
con las vistas 7 y 3 hasta colocarlo en el sitio que desees, yo lo puesto 
en la parte posterior del grifo. 
 
 
Sal del modo edición del grifo y ve a vista superior (7) , vamos a añadir una curva que será la que 
defina la trayectoria de la cadena, para ello haz Space → Curve → Path. Escala la al tamaño que 
creas oportuno. Juega con las vistas 3 y 7 para moverla a su sitio correcto y entra en modo edición 
(TAB) para darle forma.  
Verás que si mueves los distintos vértices (G) se irá doblando la curva de distintas maneras. 
 
Para ir añadiendo más vértices, 
selecciona el del extremo y 
pulsa Control + BIR y crearás 
un nuevo vértice. 
 
Ve dándole forma y añadiendo 
vértices como veas. 
 
Cambia a la vista posterior (Control + 1) sube un poco los vértices que van unidos al lavabo, deja 
el resto casi pegados al lavabo pero no del todo ya que cuando añadamos las bolas que formarán la 
cadena ya quedará pegado del todo. 

 
 
 
 
 
 
 
 
 

 
 
Bien, sal del modo edición de la cadena (TAB), crea 
una esfera (Space → Add → Mesh UvSphere)  y 
hazla pequeña. 
Ahora vamos a emparentarlas, para ello selecciona 
primero la bola y después la curva y pulsa Control+P 
→ Follow Path. 
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Aparecerá una línea que unirá los dos objetos, bien selecciona la bola y pulsa ALT+O para borrar 
su origen y se pondrá justo donde empieza la curva. 
En la ventana de objetos (F7)activa DupliFrames.  

 
 
 
 
 
 
 

 
 
 
Selecciona la curva, pulsa F9 y ajusta PathLen. Selecciona otra vez la bolita, F7 y modifica 
DupEnd con el mismo número que PathLen por ejemplo 100.  
Si te fijas al final y al principio de la cadena las bolas cada vez se juntan más, para evitar esto 
selecciona la bolita y deja pulsado el botón No Speed. 
Con esto estará la cadena hecha pero cuando se haga el render no se verá que hay ninguna curva 
que las una, para ello vamos a darle un contorno a la curva.   
 
 

Añade un Bezier circle con Space → Add → Curve → Bezier 

circle, ponle un nombre en la ventana Object and Links(F7) por 
ejemplo GrosorCadena. 
 
 
 
 
 

 
Ahora selecciona la cadena y en la ventana Curve and Surface (F9) en BevOb pon el nombre que 
le has puesto al círculo, automáticamente el círculo recorrerá toda la cadena dándole su forma, si 
quieres hacerla más ancha o más estrecha solo tienes que seleccionar el círculo y hacerlo más 
grande o más pequeño. 
 
 
 
Para hacer el tapón crea una UVSphera, en vista frontal 
(1), rótala con R + Y + 90º. Entra en modo edición y en 
selección de vértices y selecciona la mitad inferior de la 
esfera (B) y borra esos vértices.  
 

 
A continuación escala en Z a un 
tercio de su tamaño con S + Z + .3 
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En vista superior (7) y selección de caras selecciona las siguientes caras cambia a vista lateral (3) y 
estruyelas hacia arriba con E + Z, una vez estruidas, rótalas un poco tal que así; R + X 

 
 
 
 
 
 
 
 
 

Para hacer la parte de abajo del tapón pulsa / para trabajar más cómodamente y a continuación vete 
a la vista inferior (Control + 7), selecciona el loop de aristas inferior con ALT + BDR, estrúyelas y 
disminuye un poco su tamaño (E + S). A continuación en vista lateral estruye hacia abajo E + Z. 
Vuelve a vista inferior y vuelve a estruir con E + S  

 
 
 
 
 
 
 
 
 
 

 
Una vez más en vista lateral (3) estruye esta vez hacia arriba con E + Z. Si no ves bien hasta donde 
lo estás subiendo antes de estruir pulsa Z para poder ver a través de las caras. Para terminar vuelve a 
estruir y para cerrar haremos coincidir todos los vértices de esta última extrusión en uno, para ello 
pulsa E + S + 0. 
Elimina los vértices duplicados dándole al botón Rem Double.   

 
 

 
 
 
 

El valor Limit indica la distancia en que se consideran duplicados los vértices, déjalo como está en 
0.001. 
 
 
Escálalo para hacerlo coincidir con el tamaño del desagüe y rótalo un poco con R + Z. 
Para unir la cadena al tapón pulsa Space → Mesh → Torus y aparecerá un aro. Colócalo en la 
parte que quedó más levantada del tapón.   
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Vamos a hacer ahora una pastilla de jabón, para ello añade a la escena un cubo (Space → add → 

Mesh → Cube ), escálalo en Z y en X para hacerlo de forma rectangular y un poco menos alto de lo 
que era. Ahora vamos a hacer un corte, entra en modo edición (TAB), selecciona todas las caras (A) 
y pulsa K → Knife(MidPoints) después haz una línea que divida al rectángulo en dos, da igual que 
no sea muy exacta por que lo va a cortar justo a la mitad. Una vez hecho el corte pulsa INTRO. 
 
 
 
 
 
 
 
 
 
 
 
 
Ahora vamos a redondearle un poco los bordes, para ello vamos a hacerle un biselado. Para ello 
selecciona todas las caras y pulsa W → Bevel. Verá que cuando muevas el ratón se separarán los 
bordes un poco. 
Después ve a vista frontal (1) selecciona los vértices de los extremos y escálalos un poco con S + Z. 
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Después añade el modificador SubSurf (Control + 2) y dale a Set smooth para suavizar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Ahora vamos a añadir un vaso en el que pondremos un cepillo de dientes y el tubo de pasta 
dentrífica. Para hacer el vaso añade una curva (Add → Curve → Bezier Curve), en curve Tools 
pásala a Poly para manejarla mejor y haz el siguiente contorno. Ve pulsando Control + BDR para 
ir añadiendo los vértices que necesites. 
 

 
 
 
 
 
 
 
 
 
 

 
A continuación conviértela en malla para poder hacer el sólido de 
revolución, para ello sal del modo edición, y pulsa ALT + C → Convert 

Curve to Mesh. 

 
Ahora vuelve a entrar en modo edición y selecciona todos los vértices (A), en la pestaña Mesh 

Tools indicamos que vamos a hacer un giro de 360º y en 16 pasos por ejemplo. 
 
Antes de hacer el giro selecciona el vértices de abajo y pulsa 
SHIFT + S → Cursor - > Selection para poner el cursor en 
ese punto y que la revolución se haga con ese centro. 
Si pulsas en Spin y tienes en el programa varias ventanas una 
flecha con una interrogación te preguntará a partir de que 
ventana hacerlo. Tienes que hacerlo con en una donde estés en 
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vista superior (7), si no tienes ninguna división de ventanas en el programa se hará automáticamente 
en la vista que estés así que ponte antes en la vista superior. 
 
Al hacer el giro los últimos vértices coincidirán con los primeros y quedará una línea negra fea, para 
arreglarlo pulsa en el botón Rem Doubles. 
 

 
Bueno, vamos a hacer el cepillo de dientes. 

 
 
 
Crear un cubo en la escena (Space → Add → 

Mesh → Cube), escálalo hasta que tenga la 
forma de un largo rectángulo, crea dos cortes 
con Control + R y sitúalos de la siguiente 
manera.  
En vista lateral (3) selecciona los vértices de 
la parte inferior y rótala con R + X. 
Ahora selecciona los vértices de la parte 
superior y estrúyelos primero en vista lateral 
con S + Y y luego en vista frontal con S + X. 
Ahora selecciona la cara inferior y vista 
frontal (1) ensánchala un poco con S + X. 
Por último pulsa Set Smooth para suavizar 
(F9). 
 
 

 
 
 
Ahora vamos a crear la parte donde irán las cerdas del cepillo, para ello sal del modo edición (TAB) 
y crea fuera otro cubo. Escálalo hasta el tamaño que debería tener esa parte del cepillo. 
Entra en modo edición y pulsa W → Subdivide 4 veces o pulsa el botón correspondiente en la 
pestaña Mesh Tools (F9).   
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Cambia a modo Weight Paint y en la pestaña Links and Materials, crea un nuevo grupo de 
vértices y dale un nombre. Ahora en la pestaña paint modo Mix, Weight 1 y tamaño del pincel 5. 

 
 

 
 
Ahora comienza a pintar los puntos donde irán las cerdas, mientras más tiempo pulses más rojo se 
pondrá. 

 
Vamos a hacer que crezcan las cerdas para ello vuelve a Object Mode →  Panel 

Object →  Particle System (F7) . 

 
 
 
 
 
 

 

 
 
 
Ahora haz Add New → Type →  Hair. En Physics→ Normal aumentar valor. 
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Crecerá el pelo por todos lados, para limitar a que crezcan solo en donde hemos pintado id a Extras 
→  Vertex Group, pulsar el desplegable "Neg" y seleccionar el grupo de vértices creado 
anteriormente. 

  
 
 
 
 
 
 
 
 
 
 
 

 
 

Ahora para darle más densidad al pelo, pulsad en la pestaña Children y elegir Faces. 
Por último vamos a despeinar un poco el cepillo para darle un aspecto algo más usado, para ello en 
la pestaña Particle System pulsad en Set Editable, id a modo Particle Mode. 
 
 

Pulsad la tecla N para ver las propiedades, elegid el pincel 
Comb y deformar un poco las cerdas. 
Para terminar el cepillo selecciona los dos objetos que lo 
forman y únelos con CONTROL + J. 
 

 
 

 
 
 
 
Coloca el cepillo en el vaso rotándolo un poco, a continuación vamos a hacer el tubo de pasta de 
dientes. 
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Para ello crea un cilindro en la escena. Alárgalo un poco, entra en modo edición y en vista lateral 
(3) achátalo un poco de la parte de arriba y bastante de la de abajo con S + Y. 

 
    Para crear la parte de abajo selecciona la cara 
inferior (B) y estrúyela hacia abajo, muévela un 
poco para que quede torcida. 
 
 
 
 
Para que la parte de arriba no quede tan plana 
selecciona el vértice de la cara superior y muévelo 
un poco hacia arriba con G + Z. Luego cuando le 
pongamos el tapón no se verá tan puntiagudo. 
 
 
 
 
 
 
 
 

Ahora para darle un aspecto algo más realista vamos a deformarlo un poco para que parezca que 
está ya un poco gastado. Para ello vamos a utilizar la herramienta de esculpir, pero antes 
necesitamos que el objeto tenga más vértices, para ello haremos varios cortes. Ponte en modo 
selección de caras y con ALT + BDR selecciona las caras del cuerpo del cilindro. 
Ahora pulsa K → Knife (MultiCut) y pon el número de cortes en 8 por ejemplo. 

 
 
Pinta el corte y pulsa INTRO y quedará tal que 
así; 
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Bien, pasemos a Sculpt Mode. En una de las vistas pulsa N para ver las propiedades del sculpt.  
Reduce un poco el tamaño a 20 por ejemplo y la fuerza por ejemplo a 10. Pulsa el botón Sub para 
hundir la maya hacia adentro. 

Ahora toca enredar un poco hasta darle la 
forma que queramos, ve cambiando la 
vista con ALT + BDR y ve haciendo 
varios clics para hundir el modelo, si 
quieres abultar hacia afuera pues pulsa en 
vez de en Sub en Add. 
 
Juega si quieres también con la brocha 
Grab para estirar la parte de abajo y 
doblarla un poco. 

 
Para hacer el tapón crea otro cilindro y escala la base superior para hacerla 
algo más pequeña, selecciona la cara superior del cilindro y en vista superior 
estrúyela y hazla un poco más pequeña (E + S), después vuelve a estruirla esta 
vez moviéndola hacia abajo (E + Z), por último coge el vértice que queda en 
medio de la cara y súbelo un poco con G + Z. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ahora selecciona los dos objetos que forman el tubo de pasta y únelos con Control+ J. 
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Deja el tapón sin pulsar Set Smooth para que parezca con la típica rugosidad que tienen para que no 
se resbalen al girarlos. 
 
Bueno, con esto damos por terminado (falta texturizar) el modelado del lavabo, vamos a hacer 
ahora un toallero y su correspondiente toalla. 
 
Primero vamos a hacer la sujeción de la pared, 
para ello crea un cubo. Y dale la siguiente 
forma. 
A continuación selecciona todo y dale algo de 
biselado con W → Bevel. 
Por último aplica el modificador Subsurf 

(CONTROL + 2) y dale a Set Smooth. 
 

 
Si te fija en vista lateral (3) verás que la parte que iría pegada a la pared queda algo curvada por el 
modificador SubSurf, para arreglar eso vamos a afilar un poco esos bordes. Entra en modo edición 
y con B selecciona los vértices que van pegados a la pared.  
 
 
 
Pulsa SHIFT + E y estira la línea que aparece para afilar los bordes y pegarlos así a la pared, 
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Ahora vamos a hacer la parte que sujetará el 'aro' donde irá colgada la toalla, para ello crea otro 
cubo y dale la siguiente forma. Dale también un poco de biselado pero esta vez mucho menos. 

 
 
Para hacer la parte que sujetará la toalla vamos a hacerlo usando curvas. Para ello en vista frontal(1)  
haz Space → ADD → Bezier curve. Si ves que la orientación no es la adecuada rótala con R + X + 
90 tiene que verse tal que así; 

 
 
 
 
 

 
Bien, entra en modo edición y verás que por cada vértice que tiene pasa otra línea con 3 vértices, el 
del medio sirve para mover ese vértice de sitio y los otros dos para dar efecto a la curva y curvarla 
más o menos en un sentido u otro. 
 
Bueno, pues ve creando vértices con CONTROL + BIR y dándole forma a la curva hasta obtener 
una cosa tal que así; Cuando la tengas pulsa la tecla C y se cerrará la curva. 
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Lo suyo, para no hacer el dibujo tan a mano alzada hubiese sido poner una imagen de fondo en el 
menú view → Backgroud Image para ir siguiendo su contorno y que quedase algo mejor. Si 
quisieses hacer otra forma y dar a una esquina un aspecto algo más afilado selecciona ese vértice y 
presiona la tecla V. 
Bueno, selecciona todos los vértices (A) y pulsa SHIFT + D para duplicar esta curva. A 
continuación pulsa S y escálala para hacerla más pequeña. Verás que aparece un hueco en medio, 
las dos curvas se restan automáticamente. 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
Selecciona los dos vértices de abajo de la curva interna y pulsa en W → Subdivide para que 
aparezca un nuevo vértice y muévelo un poco hacia arriba. 

 
Ahora vamos a darle relieve a estas curvas. Sal del modo edición (TAB) y en la pestaña Curve 
and Surface (F9) añada algo a Extrude y verás como crece, también dale un poco a Bevel Depth 
para darle un poco de biselado. 
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Bien, vamos a añadir la toalla. Para ello crea un plano con SPACE → Add → Mesh → Plane. 
En vista superior (7) escálalo en X a la mitad ( S + X + .5 ). 
 
Luego entra en modo edición y subdivídelo 4 veces. W → Subdivide. 
 
 

Esta vez por ir siguiendo el tuto de la bibliografía vamos a darle 
un primer material y unas texturas, para ello primero vamos a 
darle un color pulsa F5 . 
 
 
 
 
 
Cambia el color que está en gris ahora a por ejemplo rojo, para 
ello haz click en el color, selecciona el que quieras y mueve el 
cursor fuera de la ventana. Ponle un nombre al material. 
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Ahora vamos a añadir unas texturas, pulsa en el botón correspondiente a las texturas. 
 
 
 
Pulsa en ADD NEW y en Texture Type elige 
DistortedNoise. Cámbiale el nombre. 
  
 
Añade una nueva textura para ello pincha en uno de los huecos disponibles y otra vez en ADD 
NEW, elige esta vez el tipo Voronoi. 
 
Vuelve a seleccionar un hueco libre y crea una nueva textura esta vez Blend. 

 
 
Ahora vuelve a la ventana Mesh Tools y pulsa el botón Noise varias veces según veas... 
Verás como se va abultando por distintos sitios. Si sales del modo edición verás que queda algo 
raro, pulsa en SetSmooth y aplica el modificador Subsurf (CONTROL+ 2) para suavizar. 

 
 
 
 
 
 

 
 
 
 
 
 
 
Bien, vamos a colgarla en su sitio.  
 
Colócala encima del sitio donde debería ir desde la vista superior (7), entra en modo edición y 
escálala en X hasta que sea un poquito más ancha que el toallero. 
Luego selecciona algunos de los vértices centrales y escálalos un poco más. A continuación ve 
seleccionando vértices con B o BB y velos moviendo (G) o escalando hasta que quede una cosa así. 
Selecciona ahora los vértices que irán justo apoyados en el toallero y desde vista frontal (1) súbelos 
un poco (G + Z) para adaptarlos al toallero. 
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Selecciona ahora la parte de la toalla que debería caer por delante y en vista lateral (CONTRL + 3) 
rótala con R + X, y muévela (G) hasta su sitio. Repite el mismo proceso con la parte trasera y ajusta 
la toalla como vayas viendo hasta colocarla en su sitio. 
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Bueno, vamos a añadir otras cosas a nuestro cuarto de baño, para ello antes de nada vamos a crear 
un cubo que formará la habitación.  
 
Crea el cubo en la escena y pulsa Z para que solo se vean las aristas y así poder ver el lavabo y 
poder colocarlo correctamente. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Para poder trabajar mejor en tiempo de modelado vamos a borrar un par de 
caras al cubo, que serán la superior y la de la puerta. Luego las pondremos 
otra vez. Para ello entra en modo edición, selecciónalas y pulsa Supr → 

Only Faces. 
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Vamos a empezar creando la bañera, para ello crea un cubo y escálalo tal que así; 
 

 
  
 
 
 
 
 
 
 
 
 
 

 
Selecciona la cara superior y bórrala con Supr → Only Faces. A continuación crea un círculo con 
ADD → Circle de 16 vértices y sitúalo en una esquina en vista superior (7). 
Selecciona los vértices que se indica y bórralos. 
 

 
 
 
 
 
 
 
 

 
 
A continuación selecciona el vértice inferior y pulsa SHIFT + S → Cursor Selection para 
posicionar ahí el cursor 3D. Cambia el pivote a 3D cursor. Selecciona todos los vértices del círculo 
ALT+BDR 
y duplícalos con SHIFT + D. Pulsa ESC para dejar de mover los vértices duplicados. Y ahora 
vamos a voltearlos, para ello pulsa CONTROL + M + -Y (la Y con un menos delante para indicar 
que volteé hacia abajo). Una vez volteados muévelos hacia abajo con G + Y, selecciona los vértices 
del medio y pulsa F para crear una arista que los una.   
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Ahora selecciona un vértice interior y repite el proceso para duplicar hacia la izquierda, esta vez con 
CONTROL + M + -X. 
 

 
 
 
 
 
 
 
 
 
 
 

 
Si quieres escalar el resultado recuerda volver a cambiar el pivote a Median Point. 
Selecciona ahora el borde superior de la bañera con ALT + BDR y el círculo que acabamos de 
crear con SHIFT + ALT + BDR y pulsa SHIFT + F para crear las caras automáticamente. 
 
 
 
 
 
 
 
 
 
Ahora selecciona solo el círculo del medio y estrúyelo desde la vista superior (7) haciéndolo un 
poco más pequeño con E +S, solo un poco. Cambia a vista lateral (3) y bájalo también un poquito 
con G + Z. 
Vuelve a estruir pero esta vez escálalo un poco más en X. Déjalo a la misma altura. 
 

 
 
Ahora vuelve a estruir, escala muy poco y baja muy poco también esta vez 
para hacer una pequeña curva. Después estruye una vez más, escala un poco 
pero esta vez bájalo bastante en la vista lateral. 
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Ahora vuelve a estruir un poquillo para hacer otra curva. Y una vez más. 
 
 
 
 
 
 
 
Y por último vuelve a estruir, esta vez no lo bajes nada en Z y desde la vista superior escálalo 
bastante hasta casi cerrar del todo el fondo 
 
 
 
 
 
 
 
 
 
 
 
Mueve este círculo central hacia un lado para hacer el desagüe. 
Para crear el desagüe crea un cilindro y hazlo un poco más grande que el agujero que ha quedado. 
Pulsa K → Knife (Mid Points) para hacer un corte a la aristas de la base superior. Una vez hecho 
el corte escálalo un poco para hacerlo casi tan grande como el cuadrado de abajo. 

  
 
 
 
 
 
 
 
 
 

Una vez hecho esto en vista lateral (3) estruye el círculo que nos ha quedado en medio de la cara 
superior y bájalo bastante, cuando lo hayas bajado escálalo para hacerlo más pequeño. 
Ahora selecciona el círculo exterior de la cara superior y bájalo un poco con ALT + BDR  y luego 
G + Z. 
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Para crear el grifo de la bañera creamos un cilindro de 32 vértices. Rótalo con R + X + 90. 
Escálalo con S + Y para dejarlo más fino.  
Coge el círculo de la base superior y hazlo un poco más fino, luego bájalo un poco. Por último sube 
el vértice de esta cara un poco hacia arriba. Después añade otro cilindro para hacer el tubo que une 
esta parte con la que gira. 
 
 
 
 
 
 
 
Ahora para crear la parte que falta añade un tercer cilindro de 20 vértices. Escálalo también para 
hacerlo más fino. Ahora selecciona los vértices de la imagen (BB), vete saltando siempre 2. 
Y escálalos con S hacia adentro. Coge los vértices centrales y súbelos un poco. 
 
 
 
 
 
 
 
 
 
 
 
Añade el modificador Subsurf (CONTROL + 2) y el Set Smooth. Por último haz un pequeño 
cilindro de 8 vértices, corta la cara superior con K → Knife Mid Points y estruye esa región un 
poco hacia adentro. Aquí pondremos luego los colores para el agua fría y caliente. 
 
 

 
 
 
 
 
 
 
 
 
 

 
Ahora duplica este objeto con SHIFT + D para crear el del agua caliente y pégalos a la pared. 
 
Bien, vamos a crear el mando para hacer que salga el agua por la ducha o por el grifo. Crea un 
cilindro que será la base, escálalo un poco para hacerlo más fino. 
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A continuación añade un texto con Space → ADD → Text, pulsa tab para entrar en modo edición 
borra la palabra Text que trae por defecto y pon DUCHA. Sal del modo edición y en la pestaña 
Curve and Surface aumenta el valor de Extrude para extruirla y el de Bevel para darle un poco de 
biselado.   
 

 
 
 
A continuación vamos a curvar un poco el texto, para ello añade una curva (Add → Curve → 

Nurbs Curve) y ponle un nombre en OB (Object) en la pestaña Links and Matarials.  

 
 
 
 
A continuación selecciona el texto y en la pestaña Font en el cuadro TextOnCurve pon el nombre 
de la curva que has creado. Verás que el texto toma la forma de la curva. Repite el proceso con la 
palabra BAÑO pero dándole la curvatura al revés y por último encájalas en el cilindro creado. 
 

 
 
 
 
 
 

 
 
Añade un pequeño cilindro en el medio que será el que sujete el mando, después añade un nuevo 
cilindro un poco más grande que el anterior, con CONTROL + R hazle un corte y muévelo un 
poco hacia el extremo. Una vez hecho el corte selecciona las caras de la imagen y extrúyelas,E 
→Region. 
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A continuación vuelve a extruirlas y esta vez hazlas un poco más pequeñas (S). Luego desde vista 
superior (7)  muévelas un poco hacia adentro.  
 

 
 
 
Para unir todo en el mismo objeto antes tenemos que convertir los textos en maya, para ello 
selecciónalos y pulsa ALT + C → Mesh. Y después con todo ya seleccionado CONTROL + J. 
 
Ahora vamos a hacer el grifo de donde saldrá también la manguera a la alcachofa de la ducha. 
Crea un círculo (ADD → Mesh → Circle) entra en modo edición y selecciona la mitad de los 

vértices. Y en la pestaña Mesh Tools pulsa el botón Split. Con esto se separarán las dos 
partes pero permaneciendo dentro del mismo objeto (al contrario que pulsando P). 

 
 
 
 
 
 
 
 
 

Ahora separa las dos partes bastante, selecciónalas y pulsa F → Skin Faces/Edge Loops para crear 
las caras automáticamente. 
 
 
 
 
 
 
 
 
 
Escálalo un poco en Z y desde vista superior (7) con todo seleccionado extruye y mueve en Y. 
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Ahora en vistas frontal (1) crea dos cortes seleccionando todo pulsando en K → Knife (MultiCut) 

y pinta un corte vertical. Selecciona los dos cortes con ALT + BDR y escálalos un poco en X. 
  
 
 
 
 
 
 
 
En selección de caras selecciona las caras de la imagen y en vista superior extrúyelas hacia afuera. 
 
 
 
 
 
 
 
 
 
A continuación crea dos cilindros y ponlos en la parte inferior a uno hazle un corte en la cara 
inferior y extrúyela hacia adentro como hicimos con el grifo del lavabo, el otro será donde irá la 
manguera. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Para hacer la alcachofa de la ducha primero vamos a hacer el enganche de la pared donde se unirá. 
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Para ello crea un cilindro, escálalo en Y hasta hacerlo muy fino, selecciona la cara superior 
extrúyela hacia afuera y hazla más pequeña. Después crea una esfera, escálala para achatarla un 
poco con S + Y, luego selecciona la mitad de los vértices (B) y muévelos hacia alante con G + Y. 

 
 
 
En vista frontal (1) con BB selecciona los vértices mostrados y extrúyelos hacia adentro con E + Y. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Luego crea una nueva Uvsphera y métela en ese hueco que ha quedado. Selecciona algunos vértices 
de esa esfera con BB y estrúyelos hacia fuera como en la imagen. 
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Ahora añade un círculo, selecciona los vértices de la imagen y bórralos. Luego selecciona el resto y 
extrúyelos hacia adentro desde vista superior (7) y luego hacia arriba desde vista lateral (3). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Para crear la alcachofa de la ducha crea un cilindro escálalo en Z hasta dejarlo bastante fino, y luego 
selecciona la cara de arriba y en vista lateral (3) ve extruyendo y escalando (E + S), moviendo (G) y 
rotando R + X, hasta obtener una figura parecida a esta; La cara inferior estrúyela también para 
hacer un hueco hacia adentro. 
 
 
 
 
 
 
 
 
 
 
Ahora añade otro cilindro en la base y ve extruyendo y rotando también hasta obtener una cosa así; 
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Coloca la alcachofa en el soporte. Una vez colocado crea 
una curva Path (Add → Curve → Path) y en modo 
edición ve creando vértices con CONTROL + BIR y 
dándole forma hasta que se unan la alcachofa con el grifo.  
 
 
 
 
Para darle cuerpo a la manguera vamos a hacerlo de forma parecida a la cadena que hicimos para el 
tapón del lavabo, pero esta vez en vez de una esfera construiremos otro tipo de eslabón. 
Crea un círculo de 16 vértices, y velo estruyendo hasta darle la siguiente forma y aplícale un 
modificador Subsurf: 

 
Ahora emparienta este eslabón con la curva que hiciste, con Control + P -> 
Follow Path, no olvides seleccionar primero el eslabón y luego la curva. 
Una vez emparentados borra el origen con Alt + O.  Ahora activa 
DupliFrames  y No Speed en la pestaña Anim Settings (F7),  
Ahora aumenta en el eslabón DupEnd a 300 y en la cadena en la pestaña 
Curve and Surface (F9) el valor de PathLen por ejemplo a 300 también, 
juega con estos dos números para hacer que no queden ni muy cerca ni muy 
lejos.  
 
Vamos a seguir con el modelado del váter, para ello primero vamos a hacer la 
cisterna. 
Crea un cubo, y escálalo en X para hacerlo un poco más ancho (p.ej; S + X + 
1.5) y en Y para hacerlo un poco más estrecho (S + Y + .8). A continuación 
entra en modo edición, selecciona todos los vértices si no lo están ya (A) y 
pulsa W → Bevel para darle un biselado.  
 
Ahora escala los vértices inferiores un poco en X y en vista lateral mete hacia 
adentro un poco los vértices inferiores con G + Y. 
 
 
A continuación selecciona los vértices de la imagen (B) y pulsa en Split para 
separar esa parte que será la tapa de la cisterna. 
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Si sales del modo edición y pulsas en Set Smooth para suavizar un poco verás que no se aprecia 
bien esta separación, para ello selecciona el loop de aristas de la base inferior de la parte que hemos 
separado y extrúyelas haciéndolas un poco más pequeñas desde vista superior (7). 
En vista lateral (3) crea 4 cortes con CONTROL + R y muévelos tal que así. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
En modo selección de caras selecciona la cara que ha quedado en medio y bórrala con Supr → 

Only Faces. A continuación crea un pequeño cubo y escálalo hasta hacerlo muy pequeño y fino y 
alárgalo, aquí es donde irá la cadena. 
 

 
 
 
 
 
 
 
 
 

 
Para hacer la cadena vamos a añadir a la escena un aro con Space → Add → Mesh → Torus, pon 
el radio mayor en 2 para hacerlo un poco más fino y lo demás déjalo como viene. Escálalo y rótalo 
para colocarlo en la cisterna.  
A continuación crea un nuevo Torus, entra en modo edición selecciona la mitad superior de los 
vértices y súbelos para arriba un poco para darle la forma al eslabón de la cadena. 
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Bien sal de modo edición y añádele un modificador Array para duplicarlo y hacer la cadena, si 
aumentas el valor a Fixed Count aumentará el número de eslabones pero aparecerán en un lado 
para arreglar esto haz lo siguiente, SPACE  → ADD → Empty. Pon el nombre que tiene en OB el 
empty al eslabón en la parte del modificador array en Object Offset. 
 
Verás que al mover el empty se moverán los eslabones, pues colócalos tal que así; Después 
selecciona el Empty y rótalo con R + Z, y los eslabones empezarán a girar.  

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
Bien ahora podríamos ir añadiendo más eslabones aumentando el valor de Fixed Count pero para 
hacerlo más cómodo vamos a crear una curva y que coja automáticamente su longitud. 
Añade una curva con Space → Add → Curve → Path después cámbiale el nombre en OB y en el 
modificador array cambia Fixed Count por Fit to Curve length y pon el nombre de la curva, al 
aumentar su tamaño nuevos eslabones aparecerán automáticamente. 
 
Para mover, rotar o escalar la cadena sin cambiar su forma selecciónala junto al Empty. 
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Para crear el 'aro' donde tirar de la cadena crear añade una curva Path (Space → Add → Curve → 

Path) y dale la siguiente forma; A continuación crea un Bezier Circle y dale la forma de la figura. 
Ponle un nombre, selecciona el aro y pon ese nombre en Bev Ob. 
Añade un nuevo Torus al final de la cadena y coloca ahí el 'aro'. 
 

 
 
 
 
 
 
 

                  Path                                        Bezier Circle 
 
 
Vamos a hacer ahora la tubería por donde saldría el agua hacia el water. Para ello selecciona la 
cisterna, ve a vista inferior con CONTROL + 7 y añade un pequeño cilindro achatándolo en Z para 
hacer el desagüe desde donde saldrá la tubería. 
A continuación vamos a crear una rosca donde enganchar la tubería y así vemos como se utiliza 
esto. Crea un plano en la escena (SPACE → Add → Mesh → Plane), rótalo con R + X + 90 para 
verlo de frente en vista frontal (1) entra en modo edición y borra uno de los vértices y gíralo un 
poco.  Escálalo haciéndolo muy chico y ponlo al lado del cilindro que acabamos de añadir.  Coloca 
el cursor 3D debajo del cilindro más o menos en la mitad de él. 
 
 
 
 
 
 
 
 
En el panel Mesh Tools cambia el valor de Steps y de Turns por ejemplo a 16 y 9 respectivamente 
y pulsa el botón Screw, si tienes varias vistas en blender en el cursor aparecerá una interrogación 
preguntándote desde que vista quieres hacerlo, hazlo desde vista frontal. 
Mientras más Steps pongas más suavizado quedará ya que aparecerán más aristas verticales y 
mientras más Turns pongas más alta será la rosca. 
 
 
 
 
 
 
 
 
 
 
 
 
Muévelo un poco hasta colocarlo en su sitio y escálalo hasta hacerlo un poco más pequeño que el 
cilindro. Pulsa Set Smooth para suavizar. 
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Duplica el cilindro que pusimos y muévelo con SHIFT + D + Z hasta dejarlo en la parte de abajo 
de la rosca. Para crear la tubería crea una curva Path y dale la siguiente forma en vista lateral(3). 
Añade ahora un Bezier Circle, ponle un nombre y eligiendo la curva path pon ese nombre en Bev 
Ob para darle el grosor a la tubería. Añade un último cilindro al final de la tubería. 
 
 

 
 
 
 
 
 
 
 
 

 
 
Bueno, vamos a hacer ahora la taza del váter, para ello crea un círculo con Space → Add → Mesh 

→ Circle. Entra en modo edición y desde vista superior (7) selecciona los vértices del dibujo. A 
continuación muévelos hacia adelante G + Y y después escálalos un poco. Después selecciona 
todos los vértices (AA), extrúyelos y escala esta extrusión (E + S) 
 
 
 
 
 
 
 
 
 
 
 
 
Cambia a vista lateral (3) y extruye hacia abajo (E + Z) 
 
 
 
Vuelve a cambiar a vista superior (7) y vuelve a extruir haciendo esta vez más 
grande. 
 
Una vez en vista lateral (3) extruye esta vez mueve hacia arriba.  
 

 
 
 
Después otra vez desde vista superior (7) extruye otra vez haciéndolo un poco 
más grande y cuando lo tengas otra vez a lateral y extruye hacia abajo. 
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Ahora ya siempre en vista lateral (3) ve extruyendo hacia abajo y ve moviendo para darle la forma 
interna.  

 

 
Cuando tengas hecha esta forma extruye una última vez y luego haz S + 0 para unir todos los 
vértices en uno y cerrar por abajo. Selecciona todos los vértices y haz un Remobe Doubles.  
Una vez hecho esto en modo selección de caras ve a la vista trasera CONTROL + 1 y selecciona 
las siguientes caras, luego desde vista lateral (3) estrúyelas. 
 
 
 
 
 
 
 
 
 
 
 
 
Vamos a hacer ahora la parte exterior, para ello antes de empezar a extruir vamos a echar algunos 
vértices un poco hacia atrás. 
 
 
Selecciona desde vista superior (7) el vértice de la imagen. Pulsa SHIFT + S → Cursor Selection 
para situar ahí el cursor 3D, cambia el pivote a 3D cursor, ahora selecciona los siguientes vértices y 
haz S + Y + 0. Una vez hecho esto los vértices estarán todos a la misma altura que el que 
seleccionamos primero, ahora muévelos un poco hacia atrás con G + Y. 
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Bien ahora ya podemos empezar a extruir,  selecciona el círculo exterior (ALT + BDR) y desde 
vista lateral (3) ve extruyendo, moviendo y escalando.  
 
 
 
 
 
 
 
 
 
 
Ahora hay que hacer las tapas para sentarse y para cerrar el water. Para hacerlo entra en modo 
edición en el váter que hemos creado, en selección de caras con ALT + BDR selecciona las caras 
de arriba. Después suplícalas con shift + D y luego sepáralas del water con P → Selected. Una vez 
hecho esto sal del modo edición del water, selecciona las caras separadas, entra en modo edición y 
extrúyelas un poco con E + Z. 

 
Para hacer la tapa haz como antes, pero esta vez en vez de seleccionar el loop de caras selecciona el 
loop de aristas externo, duplícalas con SHIFT + D y sepáralas (P). Una vez hecho esto selecciona 
esta nueva separación y rótala con R + X + 270. Colócala en su sitio. 
 
Una vez hecho esto entra en modo edición, selecciona todo, extruye y escala con E + S + 0. 
Después de borrar los vértices duplicados (Rem Doubles) estrúye con E + Y.  
Ya estaría la tapa hecha, si quieres que no quede tan plana, estruye la cara interna dos veces, una 
para hacer más pequeña y otra hacia adentro. 
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Para hacer una sujeción, selecciona las siguientes aristas, escálalas con S + X y luego extruye esas 
caras y muévelas un poco hacia afuera. 

 
 
 
 
 

 
Falta un pequeño detalle que es añadir las tuberías por donde entra el agua y la de desagüe. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Bueno, vamos con el bidé. Va a ser parecido al modelado del lavabo. Crea una UVSphere. 
Selecciona la mitad superior de los vértices y bórralos. Ahora selecciona los vértices de la segunda 
imagen (lo harás más fácil desde vista trasera Control + 1 con B y girando la vista y  seleccionando 
los que se te hayan escapado con BB, pulsa antes Z para no seleccionar nada más que los vértices 
visibles) y escálalo en Y. luego muévelo también en Y hasta que quede como en la tercera imagen.  
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Ahora selecciona todo y escala un poco en X. Luego un poco en Y para hacerla un poco más larga y 
por desde vista lateral (3) escala en Z para hacerlo menos alto. 

 
 

 
 
 
 

 
 
Mueve el círculo de caras central como hicimos con el lavabo para crear el desagüe. 
 
A continuación selecciona todos (A), suplícalos con SHIFT +D, pulsa ESC o BDR para dejar de 
mover el duplicado y escálalo (S) para hacerlo un poco más grande que el original. En vista lateral 
(3) baja un poco el duplicado (G + Z). 
 
Vuelve a seleccionar los vértices traseros y desde vista superior sepáralos un poco con G + Y. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ahora tal y como hicimos con el lavabo selecciona los dos loops de aristas superiores con ALT + 
DBR y SHIFT + ALT + BDR y pulsa F → Skin Faces/Edge Loops para crear las caras.  
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En vista inferior (CONTROL + 7) selecciona este loop de aristas y sepáralas con P → Selected,  y 
extruye hacia abajo (E + Z) para darle esta forma.  
El agujero del desagüe hazlo igual como hicimos el de la bañera.  
 

 
 
 
 
 
 
 
 
 
 
 
Para hacer el agujero por donde saldrá el agua selecciona las dos 
aristas de la imagen. 
 
 
 
 

 
 
 
 
A continuación escala en X. Luego selecciona la 
arista que ha quedado en medio y bórrala con 
Supr → Edges. 
 
 
 
 
Selecciona ahora el loop de arista del agujero (ALT + BDR) y estruye con E + Y. Luego una vez 
más con E + S + 0 para cerrar la cara. Pulsa Rem Doubles. 
Después aplica SubSurf (CONTROL + 2), si se ven líneas raras selecciona todo y pulsa Control 
+ N. 
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Para hacer los grifos del agua crea un cilindro. Con CONTROL + R crea 3 cortes y posiciónalos 
como en la imagen. Selecciona el loop de caras que ha quedado en medio y extrúyelo hacia adentro, 
y luego escálalo (E + S), hazlo desde vista superior (7), si quieres ver mejor pulsa Z para ver a 
través de las caras superiores, esta parte la colorearemos después de rojo y azul para indicar el grifo 
de agua fría y caliente. 
Después selecciona el resto de caras de abajo con B. y escálalas hacia adentro desde vista inferior 
(CONTROL + 7) con  S. 

 
 
 
 
 
 
 
 

 
Luego selecciona las aristas de esta parte inferior saltándote una. Y desde vista inferior escálalas 
(S). Hasta que quede como en la imagen. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
Crea a continuación la parte inferior del grifo como los de la bañera y añádelos al bidé. 
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Vamos a hacer ahora una ventana a la habitación, para ello selecciona el cubo que hicimos a modo 
habitación y selecciona la cara de la imagen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Desde vista lateral extrúyela (E + S) y ajusta la ventana un poco a la izquierda como en la imagen, 
ya que a la derecha pondremos un armario, escálala a tu gusto. 
Después vuelve a extruir esta vez para darle profundidad (E + X). 
Ya tenemos el hueco de la ventana para hacer el cristal, selecciona la cara de en medio y sepárala 
con P → Selected. Después sal del modo edición de la pared, entra en modo edición de la ventana y 
estrúyela hacia afuera (E + S) para hacer el marco. 

 
 
 
 
 
 
 
 
 
 
 
 

Haz un pomo de la misma manera que el mando para elegir ducha o baño de la bañera. Añade 
también un cubo para no ponerlo directamente contra el marco de la ventana y dos tornillos como 
hicimos el del desagüe del lavabo. Para unir los dos tornillos con el mango sin que se deforme por 
el Subsurf, selecciona los tornillos y en el modificador pulsa Apply y luego Control + J para unir. 
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Vamos a hacer también el marco del hueco de la pared, para ello selecciona la cara interior del 
hueco que hicimos y estrúyela hacia haciéndola un poco más grande que el cristal. luego al igual 
que con la ventana extruye esas caras hacia afuera. 
Añade un par de cilindros al marco de la pared y otro par al marco de la ventana a modo de bisagra. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

A continuación para hacer el armario que irá a la izquierda de la ventana crea un cubo y escálalo 
hasta darle el tamaño adecuado, después ve añadiendo más cubos para ir haciendo las distintas 
puertas y cajones. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Para hacer los pomos crea una esfera y escálala para hacerla un poco 
más estrecha en su perfil. A continuación desde vista trasera del pomo 
selecciona con BB un círculo de vértices y extrúyelos dos veces, la 
primera vez haz la más pequeña la extrusión y la segunda más grande. 
Duplícalos con Shift + D y ponlos en las puertas. 
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Bien, vamos a crear ahora un espejo que pondremos encima del lavabo al que le añadiremos encima 
un tubo fluorescente del que haremos que se emita luz. 
 
Vamos a hacer primero el marco del espejo, para ello crea un plano (Space → Add → Mesh → 

Plane) rótalo para verlo vertical (R + X + 90) y escálalo en X para hacerlo más alto que ancho.  
Luego en modo selección de caras (Control + Tab + 3) selecciona la cara del medio y bórrala con 
Supr → Only Faces. Vuelve a modo selección de vértices (Control + Tab + 1) y desde vista 
frontal (1) extruye haciéndolo un poco más grande. 
 
Desde vista lateral (3) mueve esos vértices un poco hacia afuera (G + Y) y repite el proceso pero 
esta vez moviendo hacia adentro. 

 
 
 
 
 
 
 
 
 
 

 
 
 
Para crear el espejo lo más fácil es seleccionar los 4 vértices internos y pulsar F para crear una Cara 
y después separarla con Split. Selecciona solo el marco y pulsa Set Smooth. 
 
Para crear la base del fluorescente crea un cubo y 
alárgalo. 

 
 
 
 
 

Para crear la sujeción del tubo crea un cilindro, rótalo 
con R + Z + 90  y escálalo en Z. Selecciona la mitad de 
los vértices y muévelos para ensanchar un poco, luego 
incrústalo en el cubo que creamos. 
 
 

 
 
 
 
 
 
 

 
El tubo es simplemente un cilindro al que hemos añadido otros dos cilindros en cada extremo 
haciendo la típica parte de metal que tienen los tubos fluorescentes. 
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Como la pared a la izquierda del lavabo queda un poco vacía vamos a hacer un perchero donde irían 
las toallas de baño para rellenar un poco ese espacio. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Para ello en primer lugar crea un cubo y dale forma rectangular, éste servirá de base para las 
perchas, luego en vista frontal (1) crea una curva Path y dale la siguiente forma añadiendo más 
vértices con Control + BIR. Una vez la tengas para cerrar la curva pulsa C y se unirán los dos 
vértices que estaban en los extremos de la curva. 
 
Ahora selecciona los 3 vértices inferiores y en vista lateral (3) ve moviendo y rotando con R + X. 
Una vez hecho selecciona ahora solo el vértice que ha quedado de punta y sepáralo un poco. 
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Ahora selecciona los 3 vértices superiores y simplemente muévelos un poco hacia 
adelante. 
 
A continuación crea un Bezier Circle y ponle un nombre en OB por ejemplo 
contorno_percha y seleccionando la curva pon ese nombre en Bev Ob. 
 
 
Luego pégalo a la base que hicimos, añade un nuevo cubo para sujetar este alambre a la base y 
ponle un par de tornillos. Una vez hecho, convierte la curva a malla con ALT + C, únela con los 
tornillos y el cubo de sujeción con CONTROL + J y duplícalo con SHIFT + D tres veces para 
hacer cuatro perchas en total. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Bien, vamos ha hacer ahora la puerta de nuestro cuarto de baño, para ello selecciona el cubo que 
forma la habitación y entra en modo edición, en modo de selección de aristas (Control+Tab+2) 
selecciona la cara donde iría la puerta con Alt + BDR, a continuación pulsa F para crear una cara.  
Ahora desde vista lateral (Control+3) estruye esa cara (E -> Región) y escálala hasta la anchura 
que debería tener la puerta. 

 
 
 
 
 
 
 
 
 
 

 
 
 
Para bajar la parte inferior de la puerta hasta la altura del suelo 
selecciona uno de los vértices inferiores del cuarto y pulsa Control + S 
-> Cursor Selection. 
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Cambia el pivote a 3D Cursor, selecciona los dos vértices inferiores de la puerta y haz S + Z + 0 
para llevar estos vértices hasta el suelo. Ahora en modo selección de caras (Control + TAB + 3) 
selecciona la puerta y bórrala con Supr -> Only Faces. 

 
 
 
 
 
 
 
 
 
 

 
Ahora selecciona las aristas que forman la puerta y estrúyelas con E + X (cambia antes el pivote a 
Mediant Point) para hacer el hueco donde irá encajada, ahora vuelve a seleccionar la puerta y 
estruye esta vez hacia dentro pero solo un poco para hacer el marco. Vuelve a estruir una vez más 
para hacer el marco escalándolo para hacerlo más grande. Y por último vuelve a estruir con E + X 
para hacerca el marco a la pared. 
 

 
 
  
 
 
 
 
 
 
 
 
 
 
 

 
Para hacer la puerta selecciona las aristas que la forman y pulsa F para crear una cara, a 
continuación pulsa en Split -> Ok para separarla del marco pero manteniéndola dentro del mismo 
objeto. Luego estrúyela con E + X para darle grosor.  Ahora copia el mango de la ventana con Shift 
+ D y llévalo hasta la puerta. Una vez lo tengas colocado en la puerta vuelve a duplicarlo con Shift 
+ D y pulsa Control + M + X para voltearlo en X y hacer el del otro lado de la puerta;  
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Vamos a hacer ahora el ‘resbalón’ para ello primero haremos un cubo que haremos muy fino un 
poco alargado y lo encajaremos en la puerta, después crea un cilindro y escálalo como en la imagen, 
entra en modo edición y elimina la mitad de los vértices desde vista superior (7), después crea las 
dos caras para cerrar la parte cortada seleccionando los vértices de 4 en 4. Por último crea dos 
tornillos y une todas las piezas que componen la puerta con Control + J. 
 

 

 
 

Ahora desde vista superior mueve la puerta a su sitio (si es que la separaste un poco para trabajar 
mejor), pulsa Z para ver mejor, entra en modo edición en la puerta y selecciona uno de los vértices 
por donde tendría que girar la puerta, pulsa Shift + S -> Cursor Selection, sal del modo edicción 
cambia el  pivote a 3D cursor y rota la puerta con R + Z para dejarla un pelín abierta. Añade 
también unas bisagras como hicimos con la ventana, por ejemplo 3 de ellas. 

 

 
Vamos a hacer ahora el interruptor de la luz al lado de la puerta; para ello crear un cubo y escálalo 
de la siguiente manera; después estruye la cara frontal donde irá el interruptor y hazla más pequeña, 
después vuelve a estruir moviéndola hacia fuera, luego vuelve a estruir y hazla más fina y esta vez  
muévelo hacia adentro; 
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Ahora selecciona el loop de aristas de la cara más grande (ALT + BDR) y muévelo en X un poco 
para acercarlo un poco a la pared. A continuación añade un cilindro dentro del objeto y rótalo 
(R+Z+90).  Escálalo hasta que encaje en el hueco que hemos dejado y luego estruye 3 caras para 
formar el interruptor. Pulsa en SetSmooth para suavizar. 
 

 
Ya que estamos con temas eléctricos vamos ha hacer también un enchufe que pondremos al lado del 
lavabo, para ello crea una Bezier Curve, rótala con R + X + 90, entra en modo edición y pulsa el 
botón Poly, vamos a hacer un rectángulo donde irán los agujeros del enchufe, para ello borra todos 
los vértices menos uno, para crear el rectángulo haz E + X + 0.5, E + Z + 1, E + X + (-0.5) y por 
último pulsa C para cerrar la curva y hacer que se cree la cara interior. Ahora añade un Bezier 
Circle  para hacer el primer agujero escálalo hasta el tamaño adecuado y duplícalo con Shift + D, 
dale algo de Estrude para darle grosor. 
 

 
Para hacer el resto del enchufe vamos a convertir antes estas curvas en malla con Alt + C, antes de 
continuar selecciona todo y haz un Remove Doubles para borrar vértices duplicados que se habrán 
creado. Ahora selecciona las aristas superiores, duplícalas con Shift + D y muévela ligeramente en 
Y para que no quede a la misma altura, luego estruye y escala esta estrusión para darle la forma 
cuadrada del enchufe. Luego estruye una vez más para hacer un marco alrededor, eleva un poco las 
caras de este marco y vuelve a estruir para unir a la pared. Ponle un par de tornillos. 
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La esquina donde está la bañera ha quedado un poco vacía así que vamos a hacer una pequeña 
repisa donde irán los botes de gel y champú. 
Para hacer la repisa primero vamos ha hacer los soportes de metal donde irá apoyada, crea un 
círculo de 24 vértices (rótalo con R +X +90), entra en modo edición y borra todos los vértices 
menos uno de los ‘cuartos’. Después estruye los vértices de los extremos con E + X + .5 y E + Z + -
.05.  Después estruye estos dos extremos para hacia fuera, vuelve a estruir el de arriba y para 
llevarlo justo hasta la altura donde está el vértice inferior selecciona éste pulsa Shift +S +4, cambia 
el pivote a modo 3D cursor y seleccionado el de arriba haz S + X + 0, después une estos dos 
vértices con F. Una vez hecho esto hay que hacer caras, ve seleccionando los vértices y pulsando F. 
Por último estruye toda esta forma para darle grosor y después añádele unos tornillos. 

 
Ahora duplica este soporte y pon encima 
un cubo dándole forma de tabla alargada 
para hacer la balda de la repisa. Une todo 
con Control + J. 
 

 
Bueno, vamos ha hacer un par de botes de champú y gel 
para ponerlos encima. 
 
Crea un cilindro y dale las proporciones de las imágenes, a 
continuación selecciona las caras superiores y suplícalas 
con Shift + D para hace el tapón, luego estruye estas caras 
en Z y escála y rota en Y para darle la siguiente forma; por 
último vuelve a duplicar con Shift + D y vuelve a estruir.  
 
Para hacer el otro bote crea un cubo y aplícale el modificador SubSurf (Control+Tab+2), achata 
un poco el cubo, a continuación entra en modo edición y seleccionando la cara inferior afila los 
bordes pulsando Shift+E. A continuación separa esa cara con Shift+D estrúyela hacia abajo (E+Z) 
y afila los bordes con Shift+E. 
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Para darle algo de color al cuarto de baño vamos a crear una planta que pondremos debajo de la 
ventana. Primero vamos con el tiesto, para ello crea un cilindro y achátalo bastante, la cara inferior 
hazla un poco más pequeña. Ahora estruye esa cara haciéndola un poco más pequeña y luego 
vuelve a estruir hacia abajo, haciendo también más pequeña la parte inferior.  
Ahora selecciona la cara superior, estrúyela haciéndola más pequeña y luego estruye hacia abajo un 
poco. 
 

 
 
 
 
Ahora vamos a hacer la tierra, para ello separa esta capa con P, sal del tiesto y entra en modo 
edición de estas caras que formarán la tierra, vamos a crear más vértices en la cara para abultarlos 
un poco, para ello pulsa K -> Knife(Multicut) y pon por ejemplo 12 cortes, pinta un círculo en 
medio de las caras y pulsa intro.  Ahora cambia a modo Proporcional a la hora de mover los vértices 
(O) y elige Random Falloff para que se distribuyan aleatoriamente los vértices. Ahora selecciona 
algún vértice y muévelo con  G + Z y los de alrededor se moverán también, repítelo con distintos 
vértices. Ahora une el tiesto y la tierra (Control + J) y pulsa Set Smooth para suavizar. 
 

 

 
 
 

 
Vamos a hacer ahora la planta, para ello vamos a crear unas 
largas hojas que luego iremos duplicando, rotando y escalando 
para formar la planta. Para empezar crea una Bezier Curve, ve 
añadiendo vértices y dale una forma parecida a la de la imagen, 
luego selecciona el vértice superior y “afílalo” pulsando V.  
Después cierra la curva pulsando C.  Ahora convierte la curva 
en malla con Alt + C. Vamos a curvar un poco la hoja, para 
ello, entra en modo edición y en vista lateral selecciona un 
grupo de vértices (B) del extremo de la hoja y rótalos y 
muévelos un poco. Haz igual con el otro extremo.
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Ahora vamos a empezar a duplicarla para ir haciendo la planta pero antes vamos a añadir un color a 
la hoja para no tener que hacerlo luego una a una con todas las hojas duplicadas. Para ello ve al 
panel de materiales (F5) pulsa en Add New y ponle un nombre, después ve al panel de texturas 
(F6) y crea una nueva. En tipo de textura elige Blend y en el panel Blend elige Lin para darle una 
progresión lineal. 
 
 
 
 
Ahora entra en la pestaña Colors y pulsa el botón ColorBand, pon en la posición 1 un color verde 
y deja el Alpha a 1, ahora ve pulsando Add para ir añadiendo más colores modificando las 
posiciones como en las siguientes capturas: 
 

 
 
Ahora ve duplicando la hoja con Shift + D y rotándola y escalándola para ir formando la planta, de 
vez en cuando modifica el duplicado para curvar un poco más la hoja para que no parezcan todas 
iguales; 

 
Con esto damos por terminado de momento el modelado del cuarto de baño, ahora toca texturizar e 
iluminar. 
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Antes de empezar a texturizar vamos a añadir a la escena algunas luces y la cámara. Vamos a crear 
de momento dos lámparas una de de tipo Lamp y la otra de tipo Sun y añadimos la cámara mirando 
hacia el lavabo que será lo primero que texturizaremos. 
Una vez hecho esto selecciona el lavabo y entra en modo edición, selecciona las caras que forman el 
desagüe, para ello ve a vista superior y selecciónalas con BB. En la pestaña Links and Materiales 
(F9) asigna estas caras al primer material del lavabo. 

 

 
 

 
Una vez hecho esto invierte la 
selección con Control + I y pulsa en 
New  para crear un nuevo material y 
vuelve a pulsar Assign, con esto 
tendremos dos materiales distintos 
para el lavabo. Ahora ve al panel de 
materiales (F5) y selecciona el 
primero de los materiales creados y 
ponle de nombre ‘Metal’. 
 
Dale el siguiente color y para que brille un poco activa Ray Mirror 
en la pestaña Mirror Transp.  
Luego pasa al material 2 ponle de nombre ‘Porcelana’ y dale un 
color blanco y activa también Ray Mirror pero algo mucho menos, 
por ejemplo 0.1. 
 
Si quieres ir viendo como va quedando para no renderizar, que puede tardar  bastante, pulsa Shift + 
P y aparecerá la ventana para previsualizar. 
 
Vamos a seguir con el grifo, esta vez vamos a crear 3 materiales, si recuerdas 
dejamos un círculo en el que se indicaría el color rojo y azul para el agua fría y 
caliente. Bien, pulsa en New 3 veces para crear los 3 materiales, ahora posiciónate 
en el primero de ellos, selecciona la mitad del círculo y pulsa en Assign, pasa al 
siguiente material, selecciona la segunda mitad del círculo y pulsa Assign,  ahora 
para seleccionar el resto del grifo vuelve al material 1 y pulsa Select, ve al 
material 2 y pulsa Select para seleccionar también las caras del segundo material y ahora pulsa 
Control + I para invertir la selección y seleccionar el resto del grifo, entonces pulsa Assign. 
Ahora ve al panel de materiales (F5), selecciona el primer material y ponle de nombre 
‘agua_caliente’ y dale un color rojo y activa Ray Mirror con valir 0.1, repite el paso con el material 
2, ponle ‘agua_fria’ y dale un color azul, y por último al grifo dale el mismo material ‘Metal’ que 
creamos antes. 
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Ahora vamos con el tapón, esta vez crea dos materiales, uno para 
la cadena y otro para el tapón. A la cadena ponle el material 
‘Metal’ y para el tapón crea uno nuevo que se llame 
‘plastico_negro’, ponle un color negro y dale también Ray 
Mirror, esta vez 0,05. 
 
 
 
 
Vamos ahora con el vaso donde está el cepillo de dientes. Añádele un nuevo 
material y ponle de nombre ‘cristal’, dale un color azulado y en la pestaña 
Shaders aumenta el valor de Spec a 1.3 y el de Hard a 400. Ahora vamos a 
hacerlo transparente para ello en la pestaña Mirror Transp activa Ray Transp. Y 
pon IOR a 1.15 y Fresnel a 5, para que también refleje un poco activa Ray 
Mirror y pon Ray Mir a 0.1. 

 
Bien, vamos ahora con la pasta de dientes, para ello utilizaremos el mapeado UV, para utilizarlo 
antes tenemos que especificar por donde queremos ‘cortar’ para obtener el patrón. Selecciona el 
tubo de pasta y entra en modo edición. En modo selección de aristas selecciona con ALT + BDR el 
loop de aristas de la imagen y pulsa Control + E -> Mark Seam para seleccionar esa costura, verás 
que las aristas seleccionadas se ponen de color naranja. Repite el proceso con el loop de aristas 
inferior. 
 
 
 
 
 
 
 
 
 
 
A continuación selecciona con Alt + BDR las aristas laterales del tubo y 
vuelve a pulsar Control + E para seleccionar esta costura. 
Una vez hecho esto pulsa L para seleccionar todas las aristas unidas a 
estas que son todo el tubo menos el tapón que texturizaremos a parte.  
 
Antes de hacer el Unwrap vamos a divider la pantalla para poner en uno 
de los modos en UV/Image Editor.  
 
Entonces si pulsamos U -> Unwrap veremos como en esta segunda 
ventana aparece el objeto ‘descosido’. 
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Bien, ahora tenemos que guardar esta imagen 
para poder editarla desde el PhotoShop (o Gimp). 
Para ello en la ventana del editor UV, abre el 
menú UVs y selecciona Scripts -> Save UV 
Face Layout.  
La siguiente ventana que aparece déjala como 
está, en ella puedes cambiar si quieres la 
resolución de la imagen, el grosor de las líneas de 
la maya. Asegura que está marcado el botón All faces para que se descarguen todas las caras 
aunque no estén seleccionadas en ese momento. 
 
 
 
 
 
Dale a Ok, y guarda el archivo con la extensión .TGA donde prefieras. 
 
Ahora abre este archivo con el photoShop o el programa que utilices. Crea una nueva capa, píntala 
entera con el pincel de blanco. En mi caso he bajado de Internet una imagen de Colgate, una de un 
código de barras y he puesto unas letras como las típicas que suelen aparecer por detrás de los tubos 
de pasta de dientes. Y las he puesto encima de la maya, si no ves bien donde estás colocando las 
cosas quítale opacidad a las nuevas capas para poder ver la maya mientras estás trabajando, pero 
acuérdate de volver a ponérsela luego, si no al grabar aparecerá la malla como parte de la textura. 
Ensancha bastante las imágenes ya que por la forma de cilindro del tubo al ponerlas en el objeto se 
extrecharán. Cuando lo tengas guarda la imagen como .tga. 

 
 
 
 
 
 
 
 

Ahora en blender, en la ventana del editor UV elige en el menú Image -> Open y elige la imagen 
que has modificado. Si sales del modo edición y eliges Textured verás que aparece la imagen sobre 
el objeto. Si la imagen sale al revés, entra en modo edición y en la ventan del editor UV elige en el 
menú UV -> Mirror -> X Axis y la imagén se dará la vuelta. 
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Si previsualizas para ver como queraría el render verás que el objeto aparece sin textura, para 
arreglar esto, tenemos que crear un material para este objeto y en la pestaña Material hay que dejar 
pulsado TexFace. 
 

 
Para darle también un material al tapón selecciona los vértices que lo forman y añade un nuevo 
material en la pestaña Links ans Materials dale un color blanco y ponle en Ray Mirror 0.05, 
ponle de nombre ‘plastico_blanco’. 
 
Para terminar con los objetos que hay en el vaso vamos a seguir con el cepillo de dientes. Para ello 
entra en modo edición, crea 2 nuevos materiales, en uno dale un color versado y activa Ray Mirror 
a 0.05, ponle de nombre ‘plastico_verde’. Al segundo asígnale el material ‘plastico_blanco’ que 
creamos antes. Ahora selecciona todas las caras que forman el cuerpo del cepillo y asígnale el 
material 1.  Para asignarle un color a las cerdas del cepillo ve al panel particle system (F7) y en la 
ventana marca Emitter para hacer la malla renderizable y en Material elige el 2 que es al que 
asignamos el material ‘plastico_blanco’. 
 
  
 
 
 
 
 
 
 
 
 
Bien, para terminar con las cosas que hay en el lavabo vamos a texturizar la pastilla de jabón. Para 
ello vamos a utilizar Proejction Painting para darle algo más de realismo. Entra en modo edición y 
pulsa U -> Unwrap (smart projections), si todavía tienes la pantalla dividida con el editor UV 
verás que aparece la pastilla de jabón ‘desglosada’.  
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En la ventana del editor UV elige Image -> New, ponle un 
nombre, por ejemplo ‘pintura_jabon’, verás que el fondo se 
queda en negro. Si vas al panel Mesh (F9) cambia el nombre 
de la textura UV a ‘resultado’, después pulsa en New para 
crear una nueva, ponle de nombre ‘pintura_jabon’, verás que 
en el editor UV aparece un cuadrado azul. Si vas al menú 
Image y eliges Open puedes cargar una imagen, en mi caso 
tengo una foto de una pastille de jabón algo reseca que tenía 
por casa en vista frontal y superior. 

Al cargar la imagen aparecerá en el editor UV. Si ahora vas a la ventana 
3D donde tienes el objeto en modo edición, seleccionas sólo las caras 
superiores de la pastilals y pulsas U -> Project From View verás que 
aparecen estas caras en el editor UV, escálalas y las colócalas en el sitio 
donde deberían ir. Repite el proceso desde vista inferior (Control +7). 
Después con las caras laterales. 
Te recomiendo que tengas la pantalla dividida 
en varias ventanas para cada vista. 

 
 
 
 
 

 
 
 

 
Una vez hecho esto con todas las caras de la pastilla, ve al modo Textura Saint y después elige el 
tipo Textured. La pastilla de jabón se quedará blanca. Bien, en la pestaña Mesh cambia las capas 
activas de la textura ‘Resultado’  y’UVText’ como en la imagen, después en la pestaña Saint elige 
el modo Clone, deja pulsado el botón Clone Layer, cambia la opacidad a 1 y aumenta si quieres el 
tamaño del pincel. 
 

 
 
Bien, hecho esto ya puedes empezar a pintar la pastilla de jabón.  
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Una vez pintada la pastilla tenemos que guardar esta imagen que hemos pintado para que al cerrar 
Blender y volver a abrirlo se cargue lo que hemos hecho, para ello en el editor UV, selecciona la 
imagen ‘pintura_jabon’ que creamos antes, que es donde en realidad se ha pintado todo esto y dale 
al menú Image -> Save As y guárdalo en la carpeta donde tengas el .blend.  
Si previsualizas la pastilla con Shift + P verás que igual que como pasaba con la pasta de dientes no 
se ve la textura, para que se vea tienes crear un nuevo material y marcar TexFace. 
 
 
 
 
 
 
 
 
 
 
Bien, vamos a continuar con el espejo. En él tendremos dos materiales, uno para el marco y otro 
para lo que es el espejo en sí. Entra en modo edición y crea dos materiales como hemos hecho co el 
grifo, etc. Selecciona la cara que forma el espejo y asígnala al primer material, luego pulsa Control 
+ IN, para invertir la selección y seleccionar el marco y asígnale el material 2. 
Para crear el espejo simplemente deja pulsado Ray Mirror y pon el valor máximo (1) a Ray Mir. 
Al segundo material dale el material ‘platico_blanco’. 
 
Ahora vamos con el tubo fluorescente, para él añadiremos 3 materiales, 1 para el soporte del tubo al 
que daremos el material ‘plastico_blanco’, otro para los extremos del tubo que serán del material 
‘metal’  y un último para el tubo en sí al que haremos que emita luz. 
Para el tubo daremos un color amarillo claro y para hacer que emita luz en la pestaña Shaders 
aumentar el valor de Emit.  
 

 
 
 
 
 
Bueno, vamos con el toallero, al soporte que va en la pared le vamos a el material ‘metal’ y al ‘aro’ 
que sujeta la toalla le vamos a poner un plástico gris translucido, para ello le damos un color gris 
oscuro al que bajaremos el Alpha y luego marcamos Ray Transp. 
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Bien, vamos a continuar con la toalla. Lo primero que vamos a hacer es cambiarle el color que le 
pusimos inicialmente a uno azul. Después iremos a cada una de las texturas que le pusimos e iremos 
cambiando el color de la pestaña Map To también a color azul. 
Hecho esto le vamos a añadir a la toalla unos pelitos, para ello igual que como hicimos con el 
cepillo de dientes cambia a modo Weight Saint y esta vez pinta toda la toalla. (Se quedará entera 
de color rojo). 
Ahora ve al panel de partículas (F7) y crea una nueva de tipo Hair, aumenta el valor de Normal al 
mínimo 0.001, y también el de Random también a 0.001 para ‘despeinarla’ un poco. 

 
Ahora para hacer crecer más pelo en la pestaña Children elige Faces y la cantidad de pelo 
aumentará. 
 
Para darle color a estos pelos iremos a la pestaña de visualización y activaremos Emitter y 
dejaremos el material 1 que es el único que tenemos. 
Por último para que nuestra toalla no brille bajaremos en el material el valor de Spec a 0 y 
aumentaremos el Hard  a 400 (pestaña Shaders). 
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Bien, antes de seguir texturizando el resto de objetos que forman el cuarto de baño vamos a 
texturizar el suelo y las paredes a las que les pondremos unas baldosas. 
Para ello vamos a utilizar las siguientes imágenes que tienen que ser cuadradas para que quede bien 
la cosa. (A la blanca no hace falta ponerle un marco, lo he puesto en el manual para que se vea). 
 
 
 
 
 
 
 
 
 
Selecciona el cubo que forma la habitación y crea 4 materiales, 2 serán para las baldosas del suelo y 
la pared y los otros para los marcos de la ventana y la puerta. 
Para crear las baldosas del suelo crearemos en este material 2 texturas en las que cargaremos en 
cada una dos imágenes diferentes. Haremos que las texturas sigan un patrón para que quede 
intercaladas como en un tablero de ajedrez. 
Es en la pestaña Map Input debemos marcar Glob y Cube, seleccionar la textura de tipo Image y 
es importante marcar Checker para hacer que vayan siguiendo el patrón. Las dos texturas son 
exactamente iguales, excepto porque cargaremos una imagen distinta en cada una y porque en una 
maracremos Odd y en la otro Even para que se vayan alternando. 
 

 
 
Si al hacer el render o la previsualización ves que quedan muy grandes, aumenta el valor de sizeX, 
Y y Z en la pestaña Map Input, pero pon el mismo valor a las dos texturas. 
 
Para las baldosas de la pared vamos ha hacerlo igual pero con unas baldosas más claras y todas del 
mismo color, antes le daremos al material un color gris oscuro que será el que se vea en las juntas 
de las baldosas. Esta vez deja pulsados tanto Odd como Even para que esta misma textura ocupe 
todos los cuadros del patrón. Aumenta también el valor de Mortar para que se vean unas líneas en 
las juntas de las baldosas.  
Las baldosas de la pared las haremos mucho más chicas que las del suelo así que aumenta más el 
valor de size  en la pestaña Map Input.  
 
Además a las baldosas de la pared le 
daremos algo de brillo, así que marca Ray 
Mirror pero dale un valor bajo, por 
ejemplo 0.05. 
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A los marcos de la ventana y la puerta le daremos un color 
amarillo pálido.  Al marco que sujeta el cristal de la ventana le 
daremos el mismo color, a los tornillos el material ‘metal’ y el 
cristal lo haremos translúcido al que añadiremos una textura Cloud para que no parezca tan liso. 

 
A la puerta le daremos el mismo material que a los marcos, y 
añadiremos el material metal a las bisagras y los tornillos, al pomo le 
daremos un dorado oscuro sin apenas brillo. Y al cubo donde va el 
‘resbalón’ de la puerta le daremos un metal pero más oscuro que el que 
teníamos. 
 

 
 
Vamos a continuar con el bidé. Al que aplicaremos 4 
materiales, para la parte principal ‘porcelana’ al igual que el 
lavabo, para el desagüe y los grifos ‘metal’, pero en ellos 
pondremos una franja roja y otra azul para indicar el aguar fría 
y caliente. 
 
 
Para la taza del bater aplicaremos también el material 
‘porcelana’ y para las tapas el material ‘plastico_blanco’. Pero 
para los tubos que salen del bater por detrás crearemos un 
nuevo material ‘plastico_gris’. 
 
 

 
 
 
A la cisterna le añadiremos 3 materiales, un ‘metal’ para la 
cadena, el ‘porcelana’ para la parte principal y los plásticos para 
los tubos.  
 
 
 
 
 
Para la bañera, 3 materiales, ‘porcelana’ para la parte interior, 
para la parte exterior aplicaremos las mismas baldosas que la 
pared, y un último ‘metal’ para el desagüe. 
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A los mandos de la ducha, le daremos el material ‘metal’, a las letras 
para elegir ‘ducha’ o ‘baño’ el otro ‘metal_oscuro’ que hicimos para 
el resbalón de la puerta, y a los grifos también añadiremos el rojo y 
azul del agua caliente y fría.  

 
 
 
 
A la sujeción de la alcachofa le daremos dos materiales ‘metal’ y 
‘metal_oscuro’. Y a la alcachofa le daremos 3, el primero para la 
parte que va a la sujeción de la pared que será de ‘metal’, el 
segundo al cuerpo en sí que será ‘plastico_negro’ y un tercero 
para la cara por donde saldría el agua que será ‘plastico_blanco’. 
 

Para los eslabones de la ducha crearemos un nuevo material ‘cromo_mate’ (cortesía de Caronte) de 
la siguiente manera; 
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Bien vamos a continuar con el perchero, a la base del perchero le pondremos una textura de madera 
y a los ganchos un material dorado. 
 
Para hacer la madera crea un material de la siguiente manera;  
 
 
Luego añádele dos texturas Clouds como las siguientes; 
 
Clouds 1; 

 
Clouds 2; 

 
 
Para hacer las perchas doradas crea un material como el siguiente y activa Ray Mirror para darle 
brillo; 
 
 

 
 
 
 
 
Seguimos con la planta, las hojas ya las tenemos texturizadas, 
para el tiesto crearemos un nuevo material anaranjado al que no 
le pondremos ningún brillo.  
 
Para hacer la tierra crearemos un material marrón oscuro al que añadiremos una textura Noise. 
Tanto en el macetero como en la tierra para quitarles brillo pondremos a Spec a 0 y subiremos 
Hard en la pestaña Shaders. 
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Continuemos con la repisa donde están los botes de champú y 
gel, para la repisa pondremos el material ‘madera’ que hicimos 
para el perchero, para las sujeciones el ‘metal’ y para los 
tornillos ‘metal_oscuro’. 
 
 
 
Para el bote grande de gel, pondremos dos colores, uno para el cuerpo y otro para el tapón. 
 
 
 
 
Ahora en el cuerpo añadiremos una etiqueta de gel que corté de una imagen de internet. Para ello 
crea en el material del cuerpo de gel una textura de tipo Image. Carga la imagen de la etiqueta y en 
el Map Input marca Orco y Tube (este lo creamos a partir de un cilindro), juega con el tamaño y 
los desplazamientos hasta que se vea bien la etiqueta. 
 
Para el champú, vamos a hacer lo mismo, pero con otra etiqueta y esta vez marcando Cube en vez 
de Tube. 
 
 
 
 

 
 
 
 
 
 
 
 
 
Para el armario, crearemos un material de color blanco sin 
brillo, para ello seleccionaremos el color blanco y en la pestaña 
Shaders bajaremos el Spec a 0 y aumentaremos el Hard a 
400.  
 

 
 
 
 
A los enchufes y el interruptor le daremos el material 
‘plastico_blanco’. 
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Bueno, pues con esto daríamos por finalizado la parte de texturización, vamos ha hacer algunos 
renders a ver que tal ha salido la cosa.  
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